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A cloud abroad in Paris
A comparison of Google Sites and Microsoft 
SharePoint Online
Intranet management is evolving, and with the right tools, your 
employees can build internal sites quickly and easily. These 
online spaces provide your staff with a centralized location 
where they can get the answers they need when they need 
them. The easier it is for everyone to set up and update these 
important hubs of communication, the more likely your teams 
will find up-to-date information within them. 

G Suite and Microsoft® Office 365® both provide site 
management tools—Google Sites™ and Microsoft SharePoint® 
Online respectively. This report provides users with real-world 
data about intranet management when the cloud tenant is 
established in the U.S. and offices across the pond use these 
shared resources.

We set up G Suite and Microsoft Office 365 accounts in the 
United States and our team in France set up and maintained 
internal sites with Google Sites and Microsoft SharePoint Online 
to see which provided the better experience.1

Google Sites delivered a streamlined user experience and 
responsive mobile design that SharePoint Online couldn’t 
match. Google Sites not only performed 100 percent of 
the routine site management task in less time, it did so with 
noticeably less effort than the Microsoft Office 365 tool. Read 
on to learn more.
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On the outs with your intranet?
We determined how long it took workers in Paris to create new sites and maintain existing ones with Google 
Sites and Microsoft SharePoint Online. We also compared the number of steps both tools required to complete 
common tasks such as adding text, images, video, and calendars to a page. Because mobility is crucial for the 
multinational enterprise, we used a variety of laptops and smartphones running different operating systems (OS), 
browsers, and apps to test real-world scenarios. 

Before we started testing in France, we set up accounts in G Suite and Microsoft Office 365 at our hands-on 
testing facility in Durham, North Carolina. We used those accounts for testing in the United States. Then, our 
team in Paris used those same accounts for testing in France. 

Read Principled Technologies’ five-part series “Not all clouds are created equal” to see how G Suite and 
Microsoft Office 365 handled collaboration and productivity tasks in the U.S.

The following scenarios describe the results of our testing in Paris, with a hypothetical headquarters in the United 
States. These scenarios give us a glimpse into how G Suite and Office 365 perform for employees that travel or 
who work outside of their U.S. headquarters.

A tale of two intranets
Isabelle and Maurice are communications coordinators for rival telecommunications groups in Europe. Part 
of their job is setting up and maintaining the internal sites used at their respective offices in Paris. They must 
embed video, add images, and edit copy for these pages. Isabelle’s company uses G Suite and Maurice’s 
company uses Microsoft Office 365.

http://facts.pt/Kwn98T
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More time for core competencies
Routine tasks shouldn’t be complicated. Our data shows that Isabel, using Google Sites, can perform every task 
in fewer steps than Maurice can using Microsoft SharePoint Online.

The real advantage isn’t only saving steps when you embed video or upload images to a page—it’s the fact that 
Google Sites is generally easier to use than Microsoft SharePoint Online (see pages 6 and 7).

Google SitesSharePoint Online

15 steps 5 steps

Embed YouTube video in page

3 steps 2 steps

Add text to a page

6 steps 1 step

Move inserted image

7 steps 2 steps

Resize inserted image

9 steps 3 steps

Add image to page from computer (upload)

4 steps 3 steps

Add calendar

7 steps 3 steps

Add bulleted list and one item

5 steps

Create new page

4 steps

4 steps

Change site/page theme
2 steps
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Isabelle outscores Maurice 3-1
Isabelle and Maurice are creating new pages and sites for their company intranets. Both need to build new 
group sales history pages for their sales teams, prepare commission breakdown pages for HR, and create 
contract sites for their legal teams. 

Our results show that Google Sites helps Isabelle finish her tasks in less time than Maurice can with SharePoint 
Online. Creating new sites on her Windows® 10 laptop takes Isabelle 3 seconds. It takes Maurice over 10 
seconds longer to do the same thing with SharePoint Online on the same laptop model! Simply put, Isabelle can 
create three new sites in the time it takes Maurice to create one. This advantage means Isabelle can start working 
on other objectives while Maurice is still far from done with his list.

Once each new project site is ready to go, Isabelle lets her coworkers know via email that their new portals 
are up and running. With Google Sites, Isabelle’s team sees her emails sooner than Maurice’s coworkers with 
SharePoint Online.

OS X®

3.9 sec12.1 sec

Windows 10
3.0 sec13.3 sec

Create a new site
 in up to

77%
less time

with Sites

OS X
0.8 sec2.2 sec

Windows 10
0.6 sec2.2 sec

Create a new 
blank page in up to

72%
less time

with Sites

OS X
2.6 sec3.4 sec

Windows 10
2.0 sec3.4 sec

Invite/share via 
email in up to

41%
less time

with Sites

Google SitesSharePoint Online
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Fast tools for staying up to date
Isabelle and Maurice now need to update their respective sites by changing the site’s color scheme and 
reviewing individual team pages.

It takes Isabelle under a second to preview a site theme with Google Sites on her Windows 10 laptop. In 
contrast, Maurice is stuck staring at his computer screen for over half a minute as he waits for SharePoint Online 
to preview the changes. This is the kind of delay that makes busy employees avoid certain tasks.

Opening a page for editing takes Microsoft SharePoint Online 1.5 times as long as it takes Google Sites. When 
workers like Isabelle and Maurice are reviewing dozens of team pages and adding new information to existing 
files, the time it takes to complete these tasks really adds up. And when they don’t have the fastest tools helping 
them, routine tasks require more time than they should.

OS X
0.8 sec19.7 sec

Windows 10
0.5 sec37.6 sec

Preview a site
theme in up to

98%
less time

with Sites

OS X
1.7 sec1.9 sec

Windows 10
1.3 sec1.9 sec

Open an existing
page for editing 

in up to

31%
less time

with Sites

Google SitesSharePoint Online
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Get the whole picture
Saving time and steps is important, but those savings aren’t the only difference between Google Sites and 
Microsoft SharePoint Online.

The Google Sites experience

Google Sites presented our testers in Paris with a consistent experience across devices, including Android™ and 
iOS smartphones. It also created responsive pages that scaled properly on both laptop and mobile screens.

Google SitesSharePoint Online

What a page editor on desktop sees

Google SitesSharePoint Online

What a user on desktop sees
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The Microsoft SharePoint Online user experience

Microsoft SharePoint Online has some mobile support, but what you see when designing a SharePoint site isn’t 
always what you get. For example, in the screenshot on the left, the page title’s formatting doesn’t match how 
it appears in the SharePoint Online editor screen on the previous page, and you see only half of the image; you 
have to scroll horizontally to see the whole thing.

In contrast, Google Sites was mobile-friendly and didn’t have any issues fluidly scaling from mobile screens to 
laptop screens.

Google SitesSharePoint Online

What a mobile user sees
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Conclusion: Google Sites makes routine tasks less complicated
Internal sites provide your employees with the information they need in one convenient location. When these 
sites are easy to maintain, they bring even more value to users, because it’s not difficult to keep that important 
information up to date. 

In our hands-on testing, Google Sites streamlined the process of site building and maintenance—each task 
took fewer steps. Every Microsoft SharePoint Online step-by-step process was more time-consuming and 
complicated. Google Sites also provided users with a consistent experience across devices, a consistency that 
was lacking in our SharePoint Online experience. Overall, we found that accomplishing day-to-day tasks using 
Google Sites was simpler and more intuitive. When we attempted the same tasks with SharePoint Online, we 
experienced up to 98 percent longer wait times. 

Want to try out the tests yourself? Follow the methodologies at the end of 
the report.

This is the fifth report in our five-part series that explores the 
performance of Microsoft Office 365 and G Suite when 
set up in the United States and accessed abroad 
from Paris. These scenarios show how the two 
suites perform for employees that travel or 
who work outside of their U.S. headquarters. 
Read the full series for a more complete 
picture of each cloud’s performance for 
multinational companies.

Additional reports in the “A cloud abroad in Paris” series:
A comparison of Google Docs™ and Microsoft Word Online

A comparison of Google Hangouts™ and Skype® for Business

A comparison of Google Drive™, Microsoft OneDrive® for Business, and SharePoint Online

A comparison of Gmail™ and Outlook®

1 For our testing, we used the rebuilt Google Sites via the Google Sites Early Adopter Program: https://cloud.googleblog.
com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html

http://facts.pt/wzNs7Q
http://facts.pt/kMZ5Vt
http://facts.pt/W6js2L
http://facts.pt/TYXpL2
https://cloud.googleblog.com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html
https://cloud.googleblog.com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html
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On August 18, 2016, we finalized the hardware and software configurations we tested. Updates for current and 
recently released hardware and software appear often, so unavoidably these configurations may not represent 
the latest versions available when this report appears. For older systems, we chose configurations representative 
of typical purchases of those systems. We concluded hands-on testing on August 18, 2016.

On September 29, 2016, Google rebranded Google Apps for Work as “G Suite.” We completed our testing 
prior to that rebranding.

Appendix A – What we tested
The table below shows the system information for the mobile devices we tested.

System Apple® iPhone 6s Plus Google Nexus™ 6P

Processor

Vendor Apple Qualcomm®

Model number A9 + M9 coprocessor Snapdragon™ 810

Core frequency (GHz) 1.85 1.95 + 1.55

Number of cores 2 8 (4 + 4)

Memory

Amount (GB) 2 (built-in onboard) 3 (built-in onboard)

Type LPDDR4 LPDDR4

Graphics

Vendor Imagination® Technologies Qualcomm

Model number PowerVR® GT7600 Adreno™ 430

Storage

Amount (GB) 64 64

Type NAND Flash NAND Flash

Connectivity 

Wireless internet 802.11ac (802.11a/b/g/n compatible) 802.11ac (802.11a/b/g/n compatible)

Cellular LTE Advanced LTE Advanced

Bluetooth 4.2 4.2

Battery 

Type Lithium-polymer Lithium-polymer

Size Integrated Integrated

Rated capacity (Wh) 10.45 13.11

Display 

Size 5.5” 5.7”

Type LED-backlit widescreen Multi-Touch AMOLED widescreen Multi-Touch

Resolution 1,080 x 1,920 1,440 x 2,560
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The table below shows the system information for the laptops we tested.

System Apple® iPhone 6s Plus Google Nexus™ 6P

Camera

Front-facing (MP) 5 (720p FaceTime® HD) 8

Rear-facing (MP) 12 (iSight®) 12.3

Operating system

Vendor Apple Google

Name iOS Android

Build number or version 9.3.2 6.0.1

Dimensions

Height 6.23” 6.27”

Width 3.07” 3.06”

Depth 0.29” 0.28”

Weight (oz.) 6.77 6.27

System Apple 13” MacBook Air® (Early 2015) Lenovo® ThinkPad® X1 Carbon

Processor

Vendor Intel® Intel

Model number Core™ i5-5250U Core i7-6600U

Core frequency (GHz) 1.6 (up to 2.7 Turbo Boost) 2.6 (up to 3.4 Turbo Boost)

Number of cores 2 2

Cache 3MB L3 4MB L3

Memory

Amount (GB) 8 (built-in onboard) 8 (built-in onboard)

Type LPDDR3 LPDDR3

Speed 1,600 MHz 1,866 MHz

Integrated graphics

Vendor Intel Intel

Model number HD Graphics 6000 HD Graphics 520

Storage

Amount (GB) 256 256

Type PCIe-based flash PCIe NVMe™ SSD
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System Apple 13” MacBook Air® (Early 2015) Lenovo® ThinkPad® X1 Carbon

Connectivity/expansion 

Wireless internet 802.11ac (802.11a/b/g/n compatible) 802.11ac (802.11a/b/g/n compatible)

Bluetooth 4.0 4.1

USB 2 x 3.0 3 x 3.0

Thunderbolt 2 x 2 N/A

Video N/A 1 x HDMI®, 1x Mini DisplayPort

Battery 

Type Lithium-polymer Lithium-polymer

Size Integrated 4-cell

Rated capacity (Wh) 54 52

Display 

Size 13.3” 14”

Type LED-backlit glossy widescreen display LED IPS

Resolution 1,440 x 900 1,920 x 1,080

Touchscreen No No

Operating system

Vendor Apple Microsoft

Name OS X El Capitan Windows 10 Pro

Build number or version 10.11.6 1511, OS Build 10586.318

Camera

Front-facing 720p FaceTime HD 720p

Dimensions

Height 0.11” to 0.6” 0.6”

Width 12.8” 13.1”

Depth 8.94” 9.00”

Weight (lb.) 2.96 2.58
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Appendix B – How we tested
About our testing
Network infrastructure

We used two of each device under test. We connected the two devices in each pair to separate wireless networks. We connected the devices 
to the 5GHz band of identical, 802.11 ac-based TP-Link AC1750 wireless routers. We configured each router identically but set them to use 
different channels, to minimize traffic from nearby networks.

Devices

• Lenovo ThinkPad X1 Carbon (Windows 10)
• Apple 13” MacBook Air (OS X El Capitan)
• Google Nexus 6P (Android 6.0.1)
• Apple iPhone 6s Plus (iOS 9.3)

OS and browser versions

• OS X El Capitan
 y Chrome™ 52.0.2743.116
 y Safari® 9.1.2 (11601.7.7)

• Windows 10
 y Chrome 52.0.2743.116 m
 y Edge 38.14393.0.0

• Android 6.0.1
• iOS 9.3.4

Running the laptop tests
Measuring the time to create a new site
1. In Google Chrome, navigate to the dashboard page for the site management service being tested.
2. Create the site:

• In Google Sites, simultaneously click the Create New Site button and start the stopwatch.
• In SharePoint Online, click the Create Site button and provide a name, then simultaneously click Create and start the stopwatch.

3. Stop the stopwatch:

• In Google Sites, stop the stopwatch when the new site appears and has fully loaded.
• In SharePoint Online, stop the stopwatch when the new site’s dashboard appears and has fully loaded.

4. Record the result. 

Measuring the time to share site via email
1. Prepare another notebook (the same model as the one being used for testing) by navigating to the browser-based email client for the 

platform under test, Gmail or Outlook Online.
2. On the notebook under test, prepare to share the site:

• In Google Sites, click the Add Editors button, provide the email address being used on the other notebook, then simultaneously click 
Done and start the stopwatch.

• In SharePoint Online, click the Share button, provide the email address being used on the other notebook, then simultaneously click 
Share and start the stopwatch.

3. When the invite email appears in the inbox on the other notebook, stop the stopwatch.
4. Record the result.
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Measuring the time to create a new blank page
1. In Google Sites, navigate to the Pages tab, or in SharePoint, navigate to the Site Contents page, and click Site Pages.
2. Create a new blank page:

• In Google Sites, click the Add Page button, provide a name for the page, then simultaneously click Done and start the stopwatch.
• In SharePoint Online, click the New button, provide a name for the page, then simultaneously click Create and start the stopwatch.

3. Stop the stopwatch:

• In Google Sites, when the new page has fully loaded and is editable, stop the stopwatch.
• In SharePoint Online, when the new page appears in the editor and is editable, stop the stopwatch.

4. Record the result.

Measuring the time to open an existing page for editing
1. Open an existing page:

• In Google Sites, navigate to the site under test, then simultaneously click the button for an existing page (that is not currently open in 
the editor) and start the stopwatch.

• In SharePoint Online, navigate to an existing page, then simultaneously click the Edit button and start the stopwatch.

2. When the page appears in the editor and is fully loaded, stop the stopwatch.
3. Record the result.

Measuring the time to preview a site theme
1. In Google Sites, click the Themes tab, or in SharePoint, click the What’s your style? button.
2. Simultaneously click a theme (other than the one you’re currently using) and start the stopwatch.
3. Stop the stopwatch:

• In Google Sites, when the new theme loads on the page in the editor, stop the stopwatch.
• In SharePoint Online, when a preview of the new theme loads, stop the stopwatch.

4. Record the result.

Measuring the number of steps to add bulleted list and one item

Google Sites

1. In the Insert menu, click Text box.
2. Click the bulleted list icon.
3. Type item text.

SharePoint Online

1. Click add an app.
2. Click Custom List.
3. Type name.
4. Click Create.
5. Click New Item.
6. Enter a title.
7. Click Save.

Number of steps to add calendar

Google Sites

1. In the Insert menu, under Google Embeds, click Calendar.
2. Click a calendar in the list to select it.
3. Click Insert.

SharePoint Online

1. Click Add lists, libraries, and other apps.
2. Click Calendar.
3. Provide name.
4. Click Create.
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Number of steps to add image to page from cloud

Google Sites

1. In the Insert menu, click Images.
2. Click the Google Drive tab.
3. Click an image to select it.
4. Click Select.

SharePoint Online

1. Click Edit.
2. Click Insert tab.
3. Click Picture.
4. Click From SharePoint.
5. Click existing image.
6. Click Insert.
7. Click Save.

Measuring the number of steps to add image to page from computer (upload)

Google Sites

1. In the Insert menu, click Images.
2. Drag an image file to the upload box from a local folder.
3. Click Upload.

SharePoint Online

1. Click Edit.
2. Click Insert tab.
3. Click Picture.
4. Click From Computer.
5. Click Choose File. 
6. Select existing image.
7. Click Open.
8. Click OK.
9. Click Save.

Number of steps to resize inserted image

Google Sites

1. Click the image in the editor.
2. Click and drag one of the circles on the corners to resize it.

SharePoint Online

1. Click Edit.
2. Click the image you want to resize.
3. Click the Image tab.
4. Click in either the Horizontal Size or Vertical Size fields.
5. Type the desired width or height in pixels.
6. Press Enter.
7. Click Save.
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Number of steps to move inserted image

Google Sites

1. In the editor, click and drag the previously embedded image to the desired location.

SharePoint Online

1. Click Edit.
2. Click the previously embedded image.
3. Click Image tab.
4. Click Position drop-down menu.
5. Click a position.
6. Click Save.

Number of steps to add text to page

Google Sites

1. In the Insert menu, click Text box.
2. Enter the text.

SharePoint Online

1. Click Edit.
2. Enter text.
3. Click Save.

Measuring the number of steps to embed YouTube video in page

Google Sites

1. In the Insert menu, under Google Embeds, click YouTube.
2. Enter a search query.
3. Press Enter.
4. Click the desired video.
5. Click Select.

SharePoint Online

1. Click Edit.
2. Click Insert tab.
3. Click Embed Code.
4. Navigate to http://www.youtube.com in another tab.
5. Enter search term or phrase.
6. Press Enter.
7. Click the desired video.
8. Click Share.
9. Click Embed.
10. Select Embed Code.
11. Copy embed code.
12. Return to the tab in which SharePoint is open.
13. Paste embed code in the Embed dialog in SharePoint.
14. Click Insert.
15. Click Save.

https://www.youtube.com/
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:
Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims 
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any 
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its 
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or result. 

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of the 
possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with Principled 
Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.

This project was commissioned by Google.

Principled
Technologies®

Facts matter.®Principled
Technologies®

Facts matter.®

Number of steps to change site/page theme

Google Sites

1. Click the Themes tab.
2. Click a theme to apply it.

SharePoint Online

1. Click What’s your style? Change the look of your site.
2. Click the desired theme.
3. Click Try it out.
4. To apply the theme, click Yes, keep it.

Number of steps to create new page

Google Sites

1. Click the Pages tab.
2. Click the Add page icon.
3. Type in the desired page name.
4. Click Done.

SharePoint Online

1. Click Site Contents.
2. Click Site Pages.
3. Click New.
4. Type in the desired page name.
5. Click Create.


